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Welcome to Cloud Communications! This guide 
is intended to get you up and running with the 
basic features associated with the product. 
For more in-depth information, please see the 
tutorial videos on our website at 
BTCBroadband.com. 

This guide covers the three main elements of 
the Cloud Communications product: 

1. Cloud Voice Portal - A web portal used for
configuration and calling history

2. MaX UC Desktop - A Windows/Mac client for
calling, instant messaging, and more

3. MaX UC Mobile - An app for iOS/Android
that includes a full-featured dialer, instant
messaging, and more

As always, you can also contact our local 
customer care team at 918- 366-8000 and we 
will be happy to assist you. 

CLOUD VOICE PORTAL

Cloud Voice Portal is the web portal used to 
configure the features on your new phone 
system. Once logged in, you can: 

• View missed calls
• Listen to voicemail messages
• Manage your contacts
• Set up rules to route your calls
• Perform many other functions

To get started, go to the login page at: 
BTCBroadband.com. (Consult your administrator 
regarding your default password. Once you log 
in, you will be prompted to create a new 
password.) 

Note: This guide is representative and images 
may vary from your individual Cloud Voice 
Portal screens. 

Getting Oriented 

Once you are logged in you will see the main 
screen with the following menu options: 

1. Messages and Calls (13) – Click this link to view and retrieve
any voicemails.

2. Contacts – Import your contacts from Outlook or create new
ones, then click on a name to dial.

3. Phone Status - Control your Call Manager settings.

4. Make Call – Make a call direct from the Cloud Voice Portal.

5. Start Meeting – Start a MaX UC Meeting.

6. Manage Webinars - Create or manage your MaX UC.

7. Security - Use these links to change your password or security
email address.

8. Downloads – Download apps, for example the MaX UC App.

9. Send Feedback – Report bugs or make suggestions for
improvements to the Cloud Voice Portal interface.

10. Your Services – Use these links to access a range of services
available with your Cloud Voice Portal account, for example to
change your call, message and notification settings, or set up a
Reminder call.

WELCOME



Messages and Calls 
The Messages and Calls tab displays all recent 
call activity. Here you can retrieve voicemails 
and view calls based on whether they were 
missed, received, dialed, or deleted.  

Click on one of the sub-tabs to get more detail. 
From the Missed, Dialed, and Received tabs 
you can click on the name and either call them, 
add them to your contacts, or jump to the 
caller’s existing contact information. 

Use the Action drop-down alongside each 
message to mark as Heard (or) New, Forward 
as Email, or Forward as Voicemail, or click the 
trash icon to delete it. 

Click the ‘play’ arrow button to listen to a 
voicemail. Note that you can listen to your 
voicemails in any order. A window (as shown 
over the Messages and Calls screen) will open 
to display the Voicemail player where you can 
listen to and manage the message. 

Click the ‘New Voicemail’ button at the top of 
the page to record and leave a voicemail as a 
memo (your computer must have a microphone 
to use this function). 

Contacts
The Contacts tab enables you to manage all of 

your contact information. Within it, you can 

create new contacts (using recent call 

information like a missed call or creating a new 

one from scratch), create groups of contacts, or 

import/export your contacts. 



The fastest way to add your contacts is to import 
them from your email program. If you use 
Microsoft Outlook, follow these instructions: 

• Open Outlook and go to the File tab, then
Import and Export

• A new window should appear

• Select Export to File and Click Next

• Select Comma Separated Values from the list
and click Next

• Select Contacts from the folder tree and click
Next

• Save exported file as ‘Outlook Contacts’ and
click Next, then save in a place you can
easily locate such as the Desktop or My
Documents

• Go back to the Cloud Voice Portal Contacts tab

• Click the Import button

• Click the Browse button to find the Outlook
Contacts file

• Click Import

• Your contacts are now in!

Call Manager
The Call Manager tab allows you to manage 
how incoming calls are routed to you. You can 
change your setting from Available to Do Not 
Disturb in the top section, which will route calls 
directly to voicemail if you’re busy. There is 
also a forwarding option that enables 
simultaneous ring with your mobile device.

Settings
The panel at the bottom of the Cloud Voice Portal 
Home page allows you to make various changes 
to your settings.  

For example: 

• To configure your phone according to your
preferences, use the Devices link. On the
screen that appears, use the ‘set keys’ link to
configure your phone according to your
preferences.

• To change your password and/or PIN, or your
security email address, click on the links under
Security at the bottom of the Home page.

The Calls Settings page allows you to control 
various call settings, for example withholding 
your caller ID and configuring Call Forwarding, 
Call Blocking or Call Jump settings.  

The Messaging Settings page enables you to 

control how your messages are handled, for 

example you manage mailbox settings, 

customize how you are notified of a voicemail, 

configure greetings, and more.

Using Voicemail Greetings you can personalize 

your voicemail greeting by recording an   

announcement (a microphone is required). 
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You can use your BTC Broadband phone service 
to make or receive calls from your desk phone, 
your PC or Mac, and your mobile devices.

For this to work on your desktop, you need to 
install the MaX UC Desktop software on your 
PC or Mac. This guide helps you to do that.

ENSURE YOUR COMPUTER IS COMPATIBLE
MaX UC Desktop works on PCs running Windows 8 (desktop 
edition) and Windows 10. It also  runs on Macs that have OS 
10.12 or later versions.

You can use your computer’s built-in microphone and speakers, 
but you will have much better audio quality if you use a headset. 
MaX UC Desktop works with most common headsets, including 
Bluetooth. It will even work with the answer/reject call button 
on some headsets.

FIND YOUR PASSWORD
You will need your BTC Cloud Voice Portal phone number and 
password to start using MaX UC Desktop.

If you don’t have this information, call us at (918) 366-8000.

You will be prompted to change the password as part of 
completing the login process.

DOWNLOAD AND INSTALL THE SOFTWARE
Download MaX UC Desktop from: voice.btcbroadband.com.

When prompted, save the file. Find the file in your downloads 
folder, open it, and follow the on-screen instructions to install 
the software.

EXPLORING MAX UC DESKTOP
MaX UC Desktop is like having your desk phone on your 
computer. You can make and receive calls, hold calls, transfer 
calls, and make three-way calls.

You can also use MaX UC Desktop to send instant messages, 
transfer files, and send Presence information to other people in 
your corporate directory who are using MaX UC Desktop (on 
any device).

MaX UC Desktop uses the Wi-Fi, broadband, or mobile  
data services available and connected to your computer.

MAKING CALLS
Making a call is as easy as entering the number on the keypad or 
clicking on a contact’s call button. 

If your contact has more than one 
number, you can choose which 
number to call from the drop-down 
list.

If the person you are calling has caller 
ID, they will see your individual BTC 
Broadband phone number.

While in an existing call, you can make a second call using 
the main client rather than the active call window. This 
automatically puts the first call on hold. When the second call is 
active, you can click on the Transfer call icon to show the held 
call as a transfer option.

MaX UC (Mobility Tool) 
for Desktop



RECEIVING CALLS
When someone calls your number, you see a pop-up window 
appear on your computer screen and hear a ringing tone through 
your speakers or headset. The pop-up shows the number of the 
person calling you. If that person’s details are already in your 
contacts list, the pop-up displays the caller’s name.

Depending on the other services you have from BTC Broadband, 
you may see the incoming call on your desk phone, on your 
mobile phone, or on a tablet device. You can answer the call on 
whichever device is most convenient for you. 

DURING THE CALL
While a call is in progress you can use the call window to:
1. Add a participant.
2.  Transfer the call.
3. Send a chat message to the caller.
4. Perform a CRM look-up.
5. Uplift the call to Meeting.
6. Put the call on hold.
7. Send video.
8. Mute your microphone.
9. Adjust the volume.
10. Access the keypad.
11. Switch to another call.
12. Record the call.
13. Merge calls.
14. End the call.

You may receive a call while you are already on another call. If 
you answer the new call, the current call is automatically placed 
on hold and the new call appears in a new call progress window. 
Switch between the two calls using the window for each one or 
click on the Merge calls icon to merge other callers into a single 
call.

VIDEO CALLING
If the person you are talking to is also using MaX UC Desktop 
on the same network, you can upgrade your call to video at 
any time. Click on the Video icon to send your video. The other 
person receives a prompt inviting them to switch on their video 
too. Click on the Video icon at any time to turn off your video 
feed.

SEND THE CALL TO SOMEONE ELSE 
Use the Call Transfer icon to send any call to another number. 
A menu pop-up allows you to select a contact, or you can type 
in a completely new number to transfer the call to. You can also 
transfer the call to another of your devices that has the MaX UC 
Client installed, without having to hang up! 

INSTANT MESSAGING
If you have MaX UC Desktop with Instant  Messaging, click on a 
contact’s Chat icon to send them  an instant message. 

From the chat window, you can send files, view your chat 
history with the contact, call the contact, and add one or more 
participants to the conversation.

REJECT CALL WITH IM
If the caller is in your Contacts list, you can reject a call and send 
the caller an instant message explaining why you can’t take the 
call. Click the drop-down list next to Reject and select one of 
the system messages, or click Custom Message to type your 
own message.

PRESENCE
Let others know whether you are 
available or busy by setting your 
presence to Online  or Busy. 

Your Presence information 
automatically shows when you are 
Away  , On the Phone , or In 
a Meeting  (this references the 
information in your Outlook calendar).

QUICK START GUIDE
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CALL MANAGER
You can tell MaX UC Desktop how to handle your incoming 
calls. Click on the Presence selector, expand the Available 
option and choose between:

  Available           

If you select Do Not Disturb, callers hear a recorded voice 
announcement saying that you are unavailable and are then 
connected to your voicemail. None of your devices will ring until 
you turn off Do Not Disturb, so be sure to use it carefully!

You can select Forwarding to forward all incoming calls to 
another number. You are then prompted to enter the number 
you want to forward calls to.

Note that when you change your Presence or Call Manager 
settings, the change applies on all of your MaX UC Clients. So, 
if you step away from your computer and forget to update your 
status, you can change your status using MaX UC Mobile on 
your mobile phone instead. 

CHOOSING WHICH CALLS TO RECEIVE
You can specify how calls should be handled if they are from 
anonymous numbers, from VIPs, or from numbers on your 
Unwanted Callers list.

To do this, click on the Presence 
selector, expand the Available 
option, and select the View all 
settings option at the end of the 
menu.

This opens the Call Manager Status window, where you can set 
your call handling preferences.

YOUR CONTACTS LIST
MaX UC Desktop assembles a contact list for you to use. 
Depending on how your service is set up, the contact list may 
include:

 – Contacts that you type directly into MaX UC Desktop.

 – Contacts in the Outlook or Mac local address book 
stored locally on your computer.

 – Contacts in Cloud Voice Portal contacts.

 – Contacts in your corporate directory.

If MaX UC Desktop is configured to automatically sync with 
Outlook, you can view and edit your Outlook contacts using 
MaX UC Desktop.

FAVORITES
For quick access to frequently-called people, add the contact to 
your Favorites list. Use the right-hand mouse button to click on 
any contact and choose Add to Favorites from the drop-down 
list. Favorites appear in the Favorites list and in the Contacts list.

CALL AND CHAT HISTORY
Click on the Recent tab to see your call and chat history. To view 
the chat history for a contact, click on the contact’s Chat icon 
then click on the History icon.

VISUAL VOICE MAIL 
If you have a voice or video message, the Message button 
changes color and indicates the number of messages received. 
Click this button to see a list of messages received, to see 
transcriptions of the messages into text (where available), or to 
listen to the messages.

EMERGENCY CALLS
MaX UC Desktop lets you make calls from anywhere on the 
most convenient device. Therefore, if you place an emergency 
call from MaX UC Desktop, the operator may not be able to 
identify where you are calling from.

TOOLS
Click on the Tools menu and select Options to access your 
general settings and test your Audio and Video devices. You can 
also access other services such as CRM, conference, file-sharing 
and cloud-hosted services from the Tools menu.

PRIVACY AND PROTECTION
Once you have finished using MaX UC Desktop, select File then 
Quit to close the application. If you are using a shared computer, 
select File then Log Out to prevent other users from accessing 
your account.

To change your log-in preferences, select Tools, Options, 
General and untick Automatically log in to MaX UC Desktop; 
this prevents MaX UC Desktop from logging in automatically 
when started and ensures that the next user has to log in using 
their own credentials.

MORE QUESTIONS?
If you have any additional questions about  
MaX UC Desktop, call us at (918) 366-8000 or  
email support@mybtc.com .

QUICK START GUIDE
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You can use BTC Broadband’s phone service to make 
or receive calls from your desk phone, your PC or 
MAC, and your mobile devices.

For this to work on your mobile or tablet, you  
need to install the MaX UC Mobile app. This guide 
helps you to do that.

ENSURE YOUR DEVICE IS COMPATIBLE
MaX UC Mobile works on:

 –  Android phones and tablets using version 6.0 or later.

 – iOS devices running iOS 11.0 or later.

Video calling only works on devices that have a front-facing 
camera.

FIND YOUR PASSWORD
You will need your BTC Cloud Voice Portal phone number and 
password to start using MaX UC Mobile.

If you don’t have this information, call us at (918) 366-8000.

You will be prompted to change the password as part of 
completing the login process.

DOWNLOAD AND INSTALL THE APP
Use the URL or QR code provided by BTC 
Broadband to find the MaX UC Mobile app 
in the App Store or Google Play. Tap Install 
to download the app to your device. Check 
the Terms & Conditions and tap Accept & 

Continue.

Tap Open on the app (if prompted, select BTC Broadband as 
your Carrier). Then if not already present, enter your password. 
Tap Log in. If you are having trouble logging in tap the eye 
symbol to show your password and check that there are no 
errors.

You may need to periodically update your password (a prompt 
appears on screen). Until you update the password, you can 
only receive calls and meeting invitations. Failure to update the 
password within the allotted time results in you being locked 
out of your account.

If you want to have the ability to switch calls to your own 
cellular network (for example, if you move to an area with poor 
Wi-Fi connection during a call made on MaX UC Mobile) enter 
your own mobile phone number and tap Continue.

EXPLORING MaX UC MOBILE
MaX UC Mobile is like having your desk 
phone on your mobile.  You can make and 
receive calls, hold calls, transfer calls, 
and make three-way calls.  You can even 
push and pull calls from your phone to 
other twinned devices, mid-call.

You can also use MaX UC Mobile to 
send messages to other people in your 
corporate directory who are using MaX 
UC (on any device).

MaX UC Mobile uses the Wi-Fi, broadband, or mobile data 
services available, so you can make and receive calls without 
using your mobile minutes.

You can access the MaX UC Mobile features using the Contacts, 
Phone, Chat and Meetings tabs at the bottom of the screen.

CONTACTS TAB
MaX UC Mobile assembles a contact list 
for you to use. Select the Contacts tab to 
view your Contacts list. Depending on how 
your service is set up, the Contacts list may 
include:

 – contacts that you type into MaX UC Mobile

 – contacts stored on your mobile device

 – contacts in Cloud Voice Portal contacts

 – contacts in your corporate directory. 

The contact’s status appears in a speech bubble next to their 
profile picture. 

Tap on a contact to access Call, Chat and Meeting options. Tap 
on the Plus icon  to add new contacts.

MaX UC (Mobility Tool) 
for Mobile



PHONE TAB
Tap on the Phone tab to make a call, view your Call History and 
listen to Voicemail.

To make a call, tap on a contact and select the number to call or 
tap on the Dialer icon  and enter the number.

If the person you are calling has caller ID, they will see your 
individual phone number. 

The Voicemail tab indicates the number of messages received. 

Tap on the Play icon to listen to a voicemail.

Tap on the Voicemail entry to see Call, Chat, Meetings and More 
options.

Tap More to access View contact, Mark as Unheard or Delete 
Message.

If you have a fax message, the Faxes tab appears; you can tap on 
it to see the fax.

CHAT TAB
Tap the Chat tab to use 
Instant Messaging. Enter 
your Chat Address and 
Password and tap Sign in. 

Tap on a contact to 
continue a previous 
conversation or click on 
the New message  icon and choose a contact to message.

From within the chat window, you can start or continue a 
conversation, send files, call a contact, or add one or more 
participants to a conversation. Your Instant Messages 
automatically sync to all your MaX UC client devices.

MEETINGS TAB
Select the Meetings tab to Create or Schedule a Meeting, Join a 
Meeting or view Upcoming Meetings.

RECEIVING CALLS
When someone calls your number, MaX UC Mobile offers the 
choice to accept or reject the call.

Depending on the other services you have from BTC Broadband 
you may also see the incoming call on your desk phone, on 
your desktop, or on a tablet device. You can answer the call on 
whichever device is most convenient for you.

DURING THE CALL
While a call is in progress you can use the call window to:

Mute your microphone.

Access the Keypad.

Turn on the Speaker.

Put the call on Hold.

Invite a Favorites contact to 
join the call.
Add/Transfer the call allows 
you to make a second call 
and add the contact into a 
3-way call or transfer the call.

Uplift the call to a Meeting.

Access More options (send 
video or switch the call to 
another device).

You may receive another call while you are already on a call. 
MaX UC Mobile gives you the option to:

 – Hold the existing call and answer the new call.

 – End the existing call and answer the new call.

 – Ignore the new call.

TRANSFER THE CALL
Tap Add/Transfer to send the call to another number. You can 
select a contact or type in a number to transfer the call to. You 
can also transfer the call to another one of your MaX UC client 
devices, without hanging up!

SWITCH THE CALL TO ANOTHER DEVICE  
If the call has poor audio due to an unreliable Wi-Fi or mobile 
data service connection, tap More then Switch and select This 
device (cellular) to move the call to your regular cell phone. 
Remember the call will now use your mobile minutes.

Alternatively, you can push the call to another of your MaX 
UC client devices, such as your desktop or your iPad. Tap More 
and then Switch and select Another device to push the call to 
whichever device is most convenient.

QUICK START GUIDE
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MORE QUESTIONS?
If you have any additional questions about  
MaX UC Mobile, call us at (918) 366-8000 or  
email support@mybtc.com .

CALL PULL
You can pull calls from your other devices onto your mobile. If 
a call exists that can be pulled, MaX UC Mobile displays a Call 
Available to Pull option. Tap this option and follow the on-
screen prompts to pull the call onto your mobile. 

VIDEO CALLING  
If the person you are talking to is also using MaX UC Mobile 
and your phone has a front-facing camera, you can add video to 
your call. Tap More then Video to send video. The other person 
receives a prompt inviting them to switch on their video. Tap on 
the Video icon at any time to turn off your video feed. 

FAVORITES    
Tap the Star icon on a contact’s directory entry to add the 
contact to Favorites. Favorite contacts appear in a banner at the 
top of the Contacts tab.

During a call, click on the Favorites 
icon to view your favorite contacts. 
Drag and drop a contact into the call 
window to setup a new call. When 
the contact answers, you can merge them into the initial call to 
create a 3-way call.

CALL NOTIFICATION
On Android devices, when you minimize the call window, the 
notification banner at the top of the screen shows the active 
call.

On iOS devices, the call notification banner displays at the 
bottom of the Phone tab.

PROFILE & SETTINGS  
Click on your avatar in the top-right to access Call, Chat, 
Contact, and Messaging settings, and additional setup options. 
You can also configure your profile, send error reports and 
access Call Manager in the Profile & Settings window.

PRESENCE
Whenever one of your contacts is signed in to their Chat 
account, MaX UC Mobile displays their presence information on 
the Contacts, Phone, and Chat tabs.

Available Away On the 

phone

Busy In a 

meeting

Do not 

disturb

Offline

CALL MANAGER 
You can tell MaX UC Mobile how to 
handle your incoming calls. Tap the 
Call Manager option in the Profile & 
Settings window and select Available, 
Do not disturb, or Forward all calls. 

If you select Do Not Disturb, callers 
hear a recorded voice announcement 
saying that you are unavailable and 
are then connected to your voicemail. 
None of your devices will ring until you 
turn off Do Not Disturb, so be sure to 
use it carefully!

Select Forward all calls and, in the 
Forwarding number box, enter the 
number you want to forward all calls to.

Note that when you change your Call Manager settings, the 
change applies on all of your MaX UC Client devices.

EMERGENCY CALLS
MaX UC Mobile lets you make calls from anywhere on the most 
convenient device. If you place an emergency call from MaX UC 
Mobile, the operator may not be able to identify where you are 
calling from.
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